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What is Power2Board?  

Power2Board is the interactive whiteboard with proven technology. It provides a collaborative infrastructure 

to let people work more effectively and deliver favorable results. It allows you to capture your handwritings 

and control your computer just by using e-pen. 

Its surface has high resistance to scratch, graffiti, corrosion, and it does not burn or contribute to flame 

spread. Its low gloss surface (80GU) gives you excellent clearness and performance under projector 

mode.  Power2Board is manufactured by Alfher Porcewol, which is the board manufacturer for 50 years, 

with integration of proven US technology to make it become the best interactive whiteboard with most 

reliable price-product relation in the market. 

  

 

  

It takes only a few seconds to connect it to your computer by USB cable or Bluetooth Wireless adapter. 

During a presentation, the receiver captures every written, drawn or projected whiteboard image and 

transfers a complete, stroke-by-stroke record of the presentation to your computer. If you choose to share 

your presentation over a LAN or the Internet, you can capture your annotated presentation along with 

annotations made by your invited audience. 

 

From the conference room to the classroom, the Power2Board is the perfect solution for more effective 

meetings and increased teamwork.  
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Get Start with Alfher Meeting Software 

Just a few of the features of the Meeting Software are:  

·  Recording data from your whiteboard in real-time (see Alfher Meeting Software).  

·  Using your whiteboard as a virtual touch-screen (see Alfher Meeting Software's Projection mode).  

·  Importing images and files into the background of your whiteboard meeting that can be shared. 

Import image files, pdf files, Powerpoint files, Excel files, Word files, and many others (see 

Background Images).  

·  Replaying, editing, and annotating images from your meetings and attach them to email messages, 

faxes, or just print.  

·  Printing the entire meeting, or just the current page to a connected printer.  

·  Saving captured meeting notes to disk in a number of different file formats.  

·  Replaying the meeting (see Play Controls).  

·  Sharing whiteboard meetings (with all imported background images and annotations) in real-time 

over your intranet or the internet. Users who are logged in can annotate the meeting remotely, while 

typing in comments in Alfher Meeting Software's chat window (see Shared Meetings).  

·  Plus many more exciting features...  

For the best guide through Alfher Meeting Software's many features, begin with the section Getting Started - 

Read Me First.  
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How does the Power2Boad technology work?  

While the Power2Board involves very advanced technology, it works according to a fairly simple principle, 

one that you've probably used yourself.  

During an electrical storm, if you start counting off seconds when you see a flash of lightning, the count 

when you hear the thunderclap can tell you how far away the storm is. This is because the light from the 

lightning travels at 670 million miles per hour, but the sound travels at only about 760 miles per hour. Thus, 

you see the lightning immediately as it flashes, but it can take several seconds for the sound of the thunder 

to reach you. If you count 8 seconds between the lightning and the thunder, the storm is about a mile away.  

The Power2Board technology works according to a similar principle. To transmit its position, the 

Power2Board electronic pen sends out a flash of infrared light, which the Power2Board "sees." The flash is 

followed by a burst of ultrasound, which the Power2Board "hears." After it sees the flash, the Power2Board 

collects data from its ultrasound receivers for long enough to guarantee that it has in memory the ultrasound 

signal from any pen that could be on the whiteboard. The Power2Board then examines the signal and 

computes the exact time it takes for the ultrasound signal to reach the receivers once the flash of infrared 

was seen. The Power2Board is able to measure this time with an accuracy of approximately +/- 3 

microseconds, producing a distance measurement accurate to +/- 1mm.  
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Getting Started - Read Me First  

The first thing you want to do is get Alfher Meeting Software up and running and connected to the hardware.  

Keep in mind that there are two parts to any system using the Power2Board technology: hardware and 

software. The hardware is set up as described in the setup instructions included in the package. This help 

system describes the software.  

There are also several different parts of Alfher Meeting Software. Alfher Meeting Software can be used to 

convert your whiteboard into:  

·  A digital whiteboard with powerful meeting sharing capabilities (using Alfher Meeting Software); or  

·  A virtual touchscreen which allows you to completely control your computer and all of your 

applications directly from the whiteboard (using a projector and Alfher Meeting Software's 

Projection mode).  

The following sessions take you to sections that help you understand what the different parts of Alfher 

Meeting Software do, as well as help you get started using the different parts of Alfher Meeting Software.  

Minimum Requirements 

Connecting Alfher Meeting Software to the hardware 

What is Whiteboard mode? 

What is Projection mode? 

What is Flipchart mode? 

Changing the whiteboard size 

How does the Power2Board technology work? 
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Minimum Requirements  

The requirements described here apply to the computer running the software. It's safe to assume that if you 

are reading this from within the help system, your computer meets the minimum requirements for running 

Alfher Meeting Software.  

Windows  

·  Windows®-compatible computer with Pentium® 100Mhz + processor  

·  Windows 98, 2000, ME, XP and Windows NT 4.0 compatible (other platform users may view shared 

meetings via JavaTM applet through Java-enabled Internet browser)  

·  10 MB available hard drive space  

·  256 color VGA or SVGA monitor  

·  CD-ROM drive or Internet connection for software installation  

·  One available serial port or USB port  

Macintosh  

Although this help system does not discuss specific Macintosh help topics, there are versions of Alfher 

Meeting Software available for Macintosh's that meet the following requirements:  

·  Power Macintosh®  

·  Mac OS X v10.1 or higher  

·  10 MB available hard drive space  

·  one available USB port  
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Connecting Alfher Meeting Software to the hardware  

After installing the software and setting up the hardware (as described in the setup instructions included in 

the package), you need to connect Alfher Meeting Software to the hardware.  

Step Name Description 

1 Connect Establish a link between the hardware and software. See How to Connect. 

2 
Select 

Mode 

Tell the software how you wish to use the system. The modes available are: 

Whiteboard mode, Flipchart mode (Windows version of Alfher Meeting Software and 

selected Power2Board configurations only), Projection mode. See How to Select a 

Mode. 

3 Calibrate Tell the software what size the whiteboard is. See Calibration. 

 

How to Select a Mode  

Alfher Meeting Software supports several different modes of operation, depending on which operating 

system you are using. These modes are:  

Mode Description 

Whiteboard Mode 

Captures notes, images and annotations drawn on the whiteboard. In 

Whiteboard mode, notes and images that you draw on the whiteboard are 

captured electronically, in color, in real time into the Alfher Meeting Software 

Alfher Meeting Software. Captured data is available for storage and display 

both locally and remotely through your local intranet or the Internet. See 

also: How to select a mode. 

Alfher Meeting Software is described in detail in Alfher Meeting Software. 

Projection Mode  

(Requires a projector to be 

attached to the same 

computer that is running 

Turns your whiteboard into a virtual touchscreen. Projection mode allows 

your whiteboard to be turned into a virtual touchscreen. You connect the 

Power2Board and a projector to your computer. The projector displays your 

computer desktop onto the whiteboard and the Power2Board detects when 

you touch the board, allowing an electronic pen (using the plastic stylus 
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Alfher Meeting Software) insert) to act as a virtual mouse used to control your computer's desktop. 

In virtual touchscreen mode, you can operate your computer directly from 

the whiteboard. You can open, work in, and close applications; draw 

freehand in painting and drawing applications, or you can operate Alfher 

Meeting Software directly from the whiteboard. See also: How to select a 

mode. 

Projection mode tools are described in Alfher Meeting Software's Projection 

mode. 

Flipchart Mode  

(Selected systems only; 

only supported in the 

Windows version of Alfher 

Meeting Software) 

Captures notes, images and annotations drawn on the Flipchart. Flipchart 

mode is identical to Whiteboard mode. Some systems that use 

Power2Board technology come with a flip chart clip. This clip attaches to a 

standard flip chart and is used to mount the Power2Board 3 hardware. 

Flipchart mode automatically sets the page size, and tells Alfher Meeting 

Software where the Shortcut Strip is located. See Shortcut Strip for Flipchart 

mode. 

Flipchart mode is used only with Alfher Meeting Software, which is 

described in detail in Alfher Meeting Software. 

See also: How to select a mode 

Disconnect 
Disconnects from the hardware, but allows you to continue using Alfher 

Meeting Software. 

Alfher Meeting Software always opens in the mode it was in when last closed. The first time that Alfher 

Meeting Software is opened, it defaults to Whiteboard mode.  

Selecting mode at Startup  

To make it easier for you to specify how you plan to use Alfher Meeting Software, the first time Alfher 

Meeting Software launches and detects portable Power2Board technology, a mode selection dialog box 

appears.  

This dialog box allows you to select which mode to use Alfher Meeting Software in (see How to Select a 

Mode). Possible selections are:  
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·  Capture from whiteboard (for Whiteboard mode)  

·  Capture from Flipchart (Flipchart mode)  

·  Use with projector (Projection mode)  

To select a mode at Startup, first select the mode that you wish to use Alfher Meeting Software in. Next, 

click the Calibration button to open the calibration wizard for to the mode you have selected.  

You can change the mode at any time by following the procedure How to select a mode.  

Go to the previous step: How to Select a Mode.  
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What is Whiteboard mode?  

In Whiteboard mode, notes and drawings that you draw on the whiteboard are captured electronically, in 

color, in real time into Alfher Meeting Software. The data you capture is available for storage and display 

both locally and remotely through your local intranet or the Internet.  

 

The Whiteboard Capture application has many useful features, such as:  

·  Recording data from your whiteboard in real-time (see Alfher Meeting Software).  

·  Using your whiteboard as a virtual touch-screen (see Alfher Meeting Software's Projection mode).  

·  Importing images and files into the background of your whiteboard meeting that can be shared. 

Import image files, pdf files, Powerpoint files, Excel files, Word files, and many others (Background 

Images).  

·  Replaying, editing, and annotating images from your meetings, and attaching them to email 

messages, faxes, or just printing.  

·  Printing the entire meeting, or just the current page to a connected printer.  

·  Saving captured meeting notes to disk in a number of different file formats.  
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·  Replaying the meeting. (For details on Rewind and replay, see Play Controls.)  

·  Sharing whiteboard meetings (with all imported background images and annotations) in real-time 

over your intranet or the internet. Users who are logged in can annotate the meeting remotely, by 

typing comments in Alfher Meeting Software's chat window (see Shared Meetings).  

The many features of the Alfher Meeting Software are described in Alfher Meeting Software.  
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What is Projection mode?  

Alfher Meeting Software's Projection mode turns your whiteboard into a virtual touchscreen. You can then 

operate your computer directly from the whiteboard.  

The Power2Board and the projector connect to your computer. The projector displays your computer 

desktop onto the whiteboard and the Power2Board detects when you touch the board, allowing your 

Power2Board pen or Power2Board's Projection Pen to act as a virtual mouse to control your computer 

desktop.  

 

In Projection mode, you can:  

·  Open, work in, and close applications.  

·  Draw freehand in painting and drawing applications.  

·  Run Alfher Meeting Software, including shared meetings, directly from the whiteboard, thus 

controlling the entire meeting directly from the whiteboard.  

·  Annotate over your desktop using the Projection toolbar. You can then print, save, or copy your 

annotations to different applications for multiple uses.  
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In Projection mode, a tap with your electronic pen on the whiteboard simulates a mouse click on your 

computer desktop. You can open, close, annotate, and save in an application from the whiteboard, just as 

you would on your own computer.  

Your Power2Board package includes a plastic stylus, which is an insert that fits into any electronic pen and 

allows you to use the electronic pen as a point and click device, instead of as a marker. The stylus is useful 

during presentations, when you want to select different areas of the projected desktop without leaving 

dry-erase marker marks on the whiteboard.  

Alfher Meeting Software's Projection mode is best used as a presentation device, where you are able to 

open, close, and show anything you need directly from the whiteboard, instead of having to walk between 

you computer and whiteboard every time you want to change something. See Using Whiteboard mode and 

Projection mode together. 

 

What is Flipchart mode?  

In Flipchart mode, notes and drawings that you draw on the flip chart are captured electronically, in color, in 

real time into Alfher Meeting Software.  

The data you capture is available for storage and display, both locally and remotely, through your local 

intranet or the Internet.  

Flipchart mode currently supports two standard flip chart sizes (27" x 34" and 25" x 30.5"), or a custom size 

that the user specifies. The flip chart clip (for supported systems) is included in the box.  

You do not need to calibrate when in flip chart mode. The Alfher Meeting Software knows the location of the 

Shortcut Strip on the flip chart clip, as well as the size of the flip chart page. The Shortcut Strip for Flipchart 

mode is described in Shortcut Strip for Flipchart mode.  

Note: Flipchart mode is available only on selected Power2Board configurations, and supported only in the 

Windows version of Alfher Meeting Software.  
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Calibration  

 

What is calibration?  

The "Image Area" of the whiteboard is the area of the whiteboard where the electronic pen strokes you 

make are captured into Alfher Meeting Software. The terms "Image Area" and "Capture Area" are used 

interchangeably. Alfher Meeting Software supports an image area from 2 to 8 feet wide, and up to 5 feet 

high. However, the actual image area supported is determined by the type of Power2Board you are using.  

Calibration defines the width and height of the image area, as well as the accurate placement of each 

captured point within the software window. The whiteboard area must always be calibrated to ensure that 

pen strokes/taps are properly detected.  

After calibration, for each new point that is tapped, the point's position is determined by Alfher Meeting 

Software relative to the calibration points. The software knows that the point must be within the calibrated 

width and height range, or the point is not valid and is thrown out. Alfher Meeting Software also uses the 

calibrated width and height to place the point within the coordinate system when recording data into Alfher 

Meeting Software.  

How to calibrate  

Whenever calibration is necessary, Alfher Meeting Software provides a calibration wizard to lead you 

through the calibration process.  

Note: When connected to a Power2Board, the first time Alfher Meeting Software is launched, a dialog box 

appears that tells you that you need to calibrate and gives you the option of calibrating immediately. For any 

single hardware configuration, Alfher Meeting Software only needs to be calibrated once. However, each 

time a Power2Board System is moved to a new location, or your computer is attached to a new system, 

Alfher Meeting Software must be calibrated again.  

It is possible for each page in a meeting to have it's own calibrated board size. This allows you to move the 

Power2Board to a different locations or use with different projectors, but continue to add pages to the same 

meeting. If there is a difference of greater than 10% in the new whiteboard size, a message dialog will 

inform you that the new whiteboard size will be used by new meeting pages, and ask you if you'd like to 

convert the current Active Page to the new whiteboard size as well.  

To calibrate Alfher Meeting Software:  

1. Setup the hardware as described by the setup instructions included in the box.  
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2. Connect Alfher Meeting Software to the hardware.  

3. Open the calibration wizard. If the calibration wizard doesn't open automatically, see the table below 

for instructions on how to open the appropriate wizard.  

Calibrate 

Mode 
Description 

Whiteboard 

Mode 

In Alfher Meeting Software, choose "Power2Board Hardware> Calibrate Capture Area" 

from the Tools menu, or from the Power2Board's Windows system tray menu, choose 

"Calibrate Capture Area." 

Projection 

Mode 
From the Power2Board's Windows system tray menu, choose "Calibrate Projection Area." 

4. Follow all on-screen directions from the calibration wizard.  

If the calibration is unsuccessful, try running the calibration again, making sure that you 
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Power2Board Aflher Meeting Software  

Alfher Meeting Software can be used in both Whiteboard and Projection mode of Power2Board, and is used 

to record, save, print, annotate, and share data from the whiteboard, as well as to share ongoing meetings 

over your local intranet or even the internet.  

To open the meeting application:  

·  Double-click the Alfher Meeting Software icon on the desktop; or  

·  Choose "Capture from Whiteboard" from the Meeting Software menu in the Windows system tray.  
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Please find the following topics in next sessions:  

Menus  

Application Toolbar  

Views and the view-change buttons  

Setting pen colors/line thickness  

Annotation Tools  

Play Controls  

Background Images  

File Import/Export/Autosave  

Supported file formats for Save As/Send  

Shared Meetings 
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Menus 

 

 

File Menu  

The File menu options are described below:  

Menu 

Selection 
Description 

New Creates a new meeting. 

Open 
Opens a standard Open File dialog box. Navigate to the *.wbd file, and selects that file to 

open. 

Close Closes the selected meeting. 

Save 

Saves the selected meeting. If this is the first time the meeting has been saved, the 

standard Save As dialog box opens allowing you to enter a meeting name and select the 

folder location. If the file has been saved before, then it is saved again under the existing 

name. 

Save As 

Opens the standard Save As dialog box, allowing you to enter a meeting name and select 

the folder location. For supported formats for saving a file, see Supported file formats for 

Save As/Send. 

Import PDA 

Meetings 
Opens the Import PDA Meeting dialog box. See Import PDA Meetings. 

Print Opens the standard Print dialog box.  

Print Page Prints the selected Page only. See also: Application Toolbar. 

Print Setup Opens the standard Print Setup dialog box. 

Page Setup 

Opens the Page Setup dialog box. The Page Setup dialog box allows you to choose 

header and footer information for the printed page, as well as whether to place a border on 

the printed page.  
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Available information includes: page numbering information, the meeting name, the date 

and time in various formats, and the Alfher Meeting Software logo. 

Send 
Opens the Send dialog box, which allows you to send the selected meeting (in various 

formats) to selected recipients using your email client. See Send. 

Exit Closes the Meeting application.  

 

Edit Menu  

The Edit menu options are described below:  

Menu 

Selection 
Description 

Undo 
Erases the previous whiteboard stroke or annotation. It is possible to undo until the page is 

blank. 

Redo 

Redoes the last undone whiteboard stroke/annotation. This option is available when Undo 

was previously clicked. In the case of multiple undos, it is possible to redo back to the final 

whiteboard stroke/annotation in the page. Redo is disabled once the next new whiteboard 

stroke/annotation occurs. 

Copy 

Copies the contents of the rectangle. The selector tool (located in Annotation Tools) allows 

you to draw a selection rectangle, then copy and paste the contents of the rectangle. Choose 

Copy from the Edit Menu to copy a selected object to the Clipboard. Data copied into the 

clipboard can be pasted into other applications. 

 

Note: It is not possible to paste copied data into another Meeting page. However, copied 

data is contained in the clipboard, and can be included in an Meeting Software meeting page 

as a background image. See Background Images. 

Delete Text 
Deletes the entire selected text box. Available only when a text box is selected. See the Text 

Tool description in Annotation Tools.  

Select All 
Selects the entire page. Used to copy the full page. See the description of Edit>Copy above. 

Available only in the full Page View. See Views and the view-change buttons.  
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Setup 

Opens the Setup dialog box. The Setup dialog box contains the following four tabs: 

·  Power2Board Hardware. See description of the Power2Board Hardware tab in 

Power2Board Hardware Setup.  

·  Proxy Server. See Proxy Server Setup.  

·  Preferences. See description of Preferences tab in Preferences - Setup.  

·  Image Size. See Image Size.  

·  Web Tour. See Web Tour Setup.  

 

View Menu  

The View menu options are described below:  

Menu 

Selection 
Description 

Toolbar 

Shows/hides the Tools (Annotation Tools) and Play Controls toolbars. Also allows you to 

choose "At top" or "At bottom" for locating the toolbars at either the top or the bottom of 

the Meeting application. 

Zoom 

Magnifies/Zooms the current page. The following settings are available for the currently 

displayed page in the Page View: Zoom In, Zoom Out, or 100%. See also: the Zoom tool 

in Annotation Tools. 

Full Screen 

Maximizes the current view to full screen size, hiding the menu bar, and maximizing the 

application if necessary. Choose Full Screen again to go back to normal mode. See 

also: Application Toolbar. 

Thumbnails Switches to the Thumbnails View. See Views and the view-change buttons. 

Participants Switches to the Participants/Chat View. See Views and the view-change buttons. 

Web Tour Switches to the Web Tour View. See Web Tour. 

Pages Switches to the Page View. See Views and the view-change buttons. 

Float 

Thumbnails 
Separates the Thumbnails View and floats it as its own window. 
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View 

Float 

Participants 

View 

Separates the Participants/Chat View and floats it as its own window. 

Float Web View Separates the Web View and floats it as its own window. 

 

Page Menu  

The Page menu options are described below:  

Menu 

Selection 
Description 

New Page 

Creates a new page in the current meeting.  

If the current meeting also contains the Active Page (page currently receiving data from 

the Power2Board system), the new page becomes the Active Page. If a different meeting 

contains the Active Page, the new page does not receive data from the Power2Board 

hardware. For details on how to set a meeting to receive data from the Power2Board 

system when multiple meetings are open, see the "Select Alfher Meeting" description in 

Tools Menu. 

Clear Page Clears everything from the selected page. 

Duplicate Page 

Duplicates the selected page, and inserts the new page following the duplicated page.  

If the current meeting also contains the Active Page and the page to be duplicated is the 

Active Page, the duplicated page becomes the Active Page. For details on how to set a 

meeting to receive data from the Power2Board system when multiple meetings are open, 

see the "Select Power2Board Meeting" description in Tools Menu. 

Delete Page Deletes the selected page. 

Delete All Deletes all pages in the selected meeting. 

Insert Page 

Before Current 
Inserts a new page before the selected page. 
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Make Current 

Page Active 

Sets the selected page as the Active Page (page currently receiving data from the 

Power2Board system). 

Next Page 
Switches to the next page in the meeting. This option is available only when the last page 

in the meeting is not currently displayed. 

Previous Page 
Switches to the previous page in the meeting. This option available only when the first 

page in the meeting is not currently displayed. 

Go To Page 
Opens the Go To Page dialog box. To select a particular page, type the page number 

and Click OK. 

Background 

Image 
Opens the Background Images dialog box. See Background Images. 

 

Meetings Menu  

The Meetings menu options are described below:  

Menu 

Selection 
Description 

Share Meeting 

Opens the Share Meetings dialog box. See Hosting/Sharing a meeting. See also: 

Sending an email invitation to a meeting. 

 

Note: This option requires that Power2Board Software be connected to the Power2Board 

receiver before the Share Meeting dialog box will launch. See Connecting Power2Board 

Software to the hardware. 

Join Meeting Opens the Join Meeting dialog box. See Joining a meeting. 

Send 

Invitation 

Opens your default email client, allowing you to select recipients from your own address 

book. See Sending an email invitation to a meeting. 

 

Note: This option requires that a shared meeting be in session. See Shared Meetings. 

Archive Choosing Archive Meeting opens a dialog box that allows you to archive your meeting on 
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Meeting Power2Board's new meeting server. See Archiving Meetings. 

Retrieve 

Meeting 

Choosing Retrieve Meeting opens a dialog box that allows you to retrieve a meeting from 

Power2Board's new meeting server. See Retrieving Archived Power2Board Meetings. 

Participants 

·  Information. Displays a dialog box showing a summary of information about the 

selected participant. Some information includes: name, role (coordinator or 

participant), interactive? (allowed to annotate?), time connected, IP address, 

domain name, and any notes entered into the notes field in the Share Meeting or 

Join Meeting dialog boxes.  

·  Set View Only. Mutes the selected meeting participant. The participant is able to 

view everything that occurs in the meeting but is not able to annotate the meeting. 

The participant can still chat in the Participants View. See also: Views and the 

view-change buttons, and Using Meeting Chat. Only available if you are the 

meeting host. See Hosting/Sharing a meeting.  

·  Exclude Participants. Disconnects the selected participant from the shared 

meeting. This option is available only if you are the meeting host. See 

Hosting/Sharing a meeting.  

·  Set View Only - All. Mutes all meeting participants. The participants are able to 

view everything that occurs in the meeting but are not able to annotate the 

meeting. The participant can still chat in the Participants View. See also: Views 

and the view-change buttons, and Using Meeting Chat. This option is only 

available if you are the meeting host. See Hosting/Sharing a meeting.  

Synchronize 

Participants 

Forces all participants to view the same page as the host. This option is only available to 

the meet host. All meeting participants are forced to view the page that the host is 

viewing. When the host switches pages, all participants automatically switch at the same 

time. See Hosting/Sharing a meeting. 

The synchronize button is available on the View control bar. See Views and the 

view-change buttons. 

 

 

Tools Menu  

The Tools menu options are described below:  



� � � � �� � � � �	 

� � � � � � ��	 � 
 ��� � �� � �

 26 

Menu 

Selection 
Description 

Power2Board 

Hardware 

·  Detect. Attempts to detect the Power2Board Hardware. See also Connecting 

Power2Board Software to the hardware.  

·  Setup. Opens the Power2Board Hardware Setup dialog box. See Selecting a 

port setting.  

·  Calibrate Capture Area. Opens the calibration wizard for whiteboard mode. 

This option is disabled in projection mode. See Calibration.  

·  Check for Firmware Upgrades. The Power2Board group is continually working 

to improve the Power2Board system. Periodically, firmware specifically for the 

Power2Board hardware is released onto Power2Board's website. This options 

allows you to check to see if firmware has been released recently, and if you 

wish, to download and install the new firmware.  

·  Bluetooth Configuration. Opens the Bluetooth Configuration dialog, which is 

used specifically for the Power2Board System Wireless system. This option will 

not work with other systems. Note: The Power2Board System Wireless receiver 

must be connected to the computer via USB cable for the configuration program 

to communicate with it.  

·  Capture from Whiteboard. Switches Power2Board Software to Whiteboard 

Mode. See How to Select a Mode.  

·  Capture from Flipchart. Switches Power2Board Software to Flipchart mode. 

Available on selected Power2Board system configurations only. See How to 

Select a Mode.  

·  Use with Projector. Switch Power2Board Software to Projection Mode. See 

How to Select a Mode.  

·  Disable System. Disconnects Power2Board Software from the hardware. Frees 

the communication port.  

Sleeve Settings Opens the Sleeve Settings dialog box. See Setting pen colors/line thickness. 

Select Meeting 

Opens the Select Meeting dialog box that allows you to select which open Power2Board 

meeting is currently receiving input from the whiteboard. Select an open meeting from 

the pull-down list, and then select OK. 

 

Note: The meeting must be open for its name to appear in the Select Meeting dialog 
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box. 

Microsoft 

NetMeeting 

Opens Microsoft NetMeeting to use for online meetings. Requires that NetMeeting has 

previously been installed on your Windows computer. See Microsoft NetMeeting. 

 

Windows Menu  

The Windows menu options are described below:  

Menu 

Selection 
Description 

Cascade Cascades all open meeting windows. 

Tile Horizontally or vertically tiles all open meeting windows. 

Meeting List 
Displays the names of all open meetings. Selecting a meeting name brings that meeting 

to the forefront. 

 

Help Menu  

The Help menu options are described below:  

Menu Selection Description 

Contents Opens the online help system. 

Online Support Opens your web browser and loads the www.nectosystems.com support page. 

Registration 
Opens your web browser and loads the www.nectosystems.com registration 

page. 

Common Questions Opens your web browser and loads the www.nectosystems.com FAQs page. 

Software Update 
Opens your web browser and loads the www.nectosystems.com downloads 

page. 

Check for Updates Opens the Check Application Version dialog box. See Checking For Software 
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Updates. 

System Diagnostics This option is used only by technical support.  

System Information Opens the standard System Information dialog box. 

About Power2Board 

Software 

Displays the About dialog box for Power2Board Software. To close, click 

anywhere in the About dialog box. 
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Application Toolbar  

Power2Board Software's meeting application toolbar is located at the top of the meeting application window, 

under the menu bar. See also: Power2Board Software Toolbar Preferences.  

 

Toolbar 

Button 
Description 

New 

Creates a new page in the current meeting. Also available in the Page Menu. 

If the current meeting also contains the Active Page (page currently receiving data from the 

Power2Board system), then the new page becomes the Active Page. For details on how to 

set a meeting to receive data from the Power2Board system when multiple meetings are 

open, see the "Select Power2Board Meeting" description in Tools Menu. 

Duplicate 

Duplicates the selected page, and inserts the new page following the duplicated page. Also 

available in the Page Menu. 
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If the current meeting also contains the Active Page and the page to be duplicated is the 

Active Page, then the duplicated page becomes the Active Page. For details on how to set a 

meeting to receive data from the Power2Board system when multiple meetings are open, see 

the "Select Power2Board Meeting" description under Tools Menu. 

Delete Deletes the selected page. Also available in the Page Menu. 

Print Prints the selected page. Also available in the Page Menu. 

Full 

Screen 

Maximizes the current view to full screen size, hiding the menu bar, and maximizing the 

Meeting application, if necessary. To go back to normal mode, click Full Screen again. Also 

available in the View Menu. 

Share 

Meeting 

Opens the Share Meeting dialog box. See Hosting/Sharing a meeting. See also: Sending an 

email invitation to a meeting. Also available in the Meetings Menu. 

 

Note: This option requires that the Power2Board Software be connected to the Power2Board 

hardware before the Share Meeting dialog box will launch. 

Join 

Meeting 

Opens the Join Meeting dialog box. See Joining a meeting. Also available in the Meetings 

Menu. 

View Only 

Mutes the selected meeting participant. The participant is able to view everything that occurs 

in the meeting but is not able to annotate the meeting. The participant can still chat in the 

Participants View.  

 

Note: This option is shown only when the Participants/Chat View is displayed. 

See also: Views and the view-change buttons, and Using Meeting Chat. Also available in the 

Meetings Menu. 

 

Note: Only available if you are the meeting host. See Hosting/Sharing a meeting. 

View Only 

- All 

Mutes all meeting participants. The participants are able to view everything that occurs in the 

meeting, but are not able to annotate the meeting. The participants can still chat in the 

Participants View.  
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Note: This option is shown only when the Participants/Chat View is displayed. 

See also: Views and the view-change buttons, and Using Meeting Chat. Also available in the 

Meetings Menu. 

 

Note: This option is only available if you are the meeting host. See Hosting/Sharing a 

meeting. 

Exclude 

Disconnects selected participant from the shared meeting. This option is shown only when 

the Participants/Chat View is displayed. 

See also: Views and the view-change buttons, and Using Meeting Chat. Also available in the 

Meetings Menu. 

 

Note: This option is only available if you are the meeting host. See Hosting/Sharing a 

meeting. 
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Views and the view-change buttons  

The view area is the center of Power2Board Software's Meeting application window. Power2Board 

Software's Meeting application has several views:  

·  Page Display View: The Page Display View displays a single meeting page at one time, allowing 

you to see each new whiteboard drawing as it is drawn.  

·  Participants View: The Participants View shows you who is logged into a shared meetings, and 

allows the logged in participants to chat online. See also: Using Meeting Chat.  

·  Thumbnails View: The Thumbnails View displays thumbnails of all pages in the meeting. Use the 

scroll bar on the right to scroll through all available thumbnails. Selecting a thumbnail opens that 

page in the Page Display View.  

·  Web View: The Web View allows access to web pages, and allows the meeting host to lead a Web 

Tour.  

The View-Change toolbar (shown below) is used to navigate between the different views.  

 

Each control in the View-Change toolbar is described below:  
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Control Description 

Switch To 

Participants View 

Button 

Switches to the Participants View. See Using Meeting Chat. 

Switch to 

Thumbnails View 

Button 

Switches to the Thumbnails View. 

Switch to Web 

View Button 
Switches to the Web View. See Web Tour. 

Page Select 

Scrollbar 

Displays a page button for all pages contained in the meeting. The button for the 

currently displayed page in the Page View is larger and overlaps the other page 

buttons (see example for page 1 in the image above). If the number of pages exceeds 

the amount of space in the scroll bar, the scrolling arrows become active. See also: 

Reordering meeting pages. 

 

Note: Rolling your mouse pointer over a page button causes a thumbnail of that page 

to pop up (see example for page 5 in the image above). This allows you to see the 

page without displaying the page in the Page View. Moving the mouse pointer away 

from the page button closes the pop-up. 

Currently 

Displayed Page 

Shows the currently displayed page in the Page Display View. When a page is 

displayed in the Page Display View, the corresponding button in the Page Select 

Scrollbar is larger than the other buttons. See also: Reordering meeting pages. 

Mouse Rollover - 

Quick Page 

Preview 

Opens thumbnail. Rolling your mouse over a page on the Page Select Scrollbar and 

then holding it for a second causes a thumbnail of the page to pop up. Moving the 

mouse away from the Page Select Scrollbar closes the thumbnail. 

Active Page 

Shows the Active Page icon that is currently receiving whiteboard data from the 

hardware. See also: Make Current Page Active from the Page Menu, and Reordering 

meeting pages. 

Previous Page/ 

Next Page 
Displays the previous or next page in the meeting. Previous Page button enabled only 
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Buttons if the currently displayed page is not the first page in the meeting.  

 

Note: The Next Page button is enabled only if the currently displayed page is not the 

last page in the meeting. 

Synchronize 

Button 

Causes all participants to be forced to view the same page as the meeting host. For 

details, see the Synchronize feature in What can the meeting coordinator do? 

 

Reordering meeting pages  

You can reorder or move meeting pages on the Page Select scrollbar by using your mouse to drag a page 

to a new location.  

As you drag the page, and indicator arrow appears on the scrollbar that lets you know where the page will 

be inserted. Once the page has been moved, all pages are immediately renumbered. If you have moved a 

page to a higher page number location, all other pages will shift down. If you move a page to a lower page 

number location, all other pages will shift up.  

Note: You cannot undo a page move.  
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Setting pen colors/line thickness  

The Sleeve Settings dialog box defines how strokes made on the whiteboard with an Power2Board marker 

are represented in Power2Board Software's Meeting application window.  

Power2Board Software's Meeting application has default screen colors and line thickness already defined; 

however, you can modify these default colors and line thicknesses to suit your needs.  

 

To set pen colors and line thickness:  

1. Choose "Sleeve Settings" from the Tools Menu.  

2. Select the desired line thickness for each electronic pen. Each electronic pen has a corresponding 

picture and set of line thicknesses in the Sleeve Settings dialog box.  

Note: On-screen line weights may appear thicker or thinner than the actual marker strokes on 

the whiteboard.  
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3. Select the desired screen colors for each electronic pen.  

�  The Color dialog box appears.  

�  Your screen colors can differ from the dry-erase marker and the ring on the electronic pen, if 

desired. You can create your own colors or use the basic colors provided.  

�  In the Sleeve Settings dialog box, the screen color bar changes to reflect the color you 

selected for each sleeve color.  

�  To return the sleeve colors to the default setting, click the Restore Defaults button.  

4. Click OK to save your color choices.  

Changing width/color of previously recorded strokes  

To change width/color of previously recorded strokes:  

1. Choose "Sleeve Settings" from the Tools Menu.  

2. Select the desired new line width/new color.  

3. For both the line width, and line color, select "Apply to Previous Strokes", and specify if you would 

like this to apply to the current page only or all pages in the meeting.  

4. Click OK to apply the width change.  

Note: Changes to the color or line width of pen strokes cannot be undone.  
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Annotation Tools  

The Annotation Toolbar is a palette of tools that allow the user to annotate/draw on the displayed meeting 

page using the computer's mouse and keyboard.  

Some uses for the Annotation tools include:  

·  Highlighting an important item on the whiteboard.  

·  Adding text notes to a page that elaborate on the meaning of the whiteboard drawing.  

·  Highlighting items that remote participants should pay close attention to during a shared meeting. 

See Using Annotation Tools during a Shared Meeting.  

·  Creating meeting pages, when using Power2Board Software's Meeting application in Projection 

mode. See Using whiteboard mode and projection mode together).  

 

The Annotation toolbar is displayed below along with a table of descriptions (from left to right) of each tool:  
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Tool Description 

Marker 

The Marker tool allows you to annotate the displayed page freehand in one of four solid 

colors. The color can be selected from the palette that appears when the Marker tool is 

selected. 

Highlighter 

The Highlighter tool allows you to annotate the displayed page freehand in one of four 

transparent colors. The color can be selected from the palette that appears when the 

Highlighter tool is selected. 

Eraser 

The Eraser tool allows you to erase (from the displayed page) both the marker strokes drawn 

on the whiteboard and the annotation marks made with the Annotation tools. The eraser size 

can be selected from the palette that appears when the Eraser tool is selected. 

Zoom 

The Zoom tool allows you to adjust the viewing size of the displayed page. The range of zoom 

values are 100-2000%. Holding down the Shift key reverses the zoom direction. A zoom value 

can also be selected from the pull-down list that appears when the Zoom tool is selected. 

Text 

The Text tool allows you to add text annotations to a meeting in any size, font, and color 

available on your computer. The size, font, and color may be selected from the palette that 

appears when the Text tool is selected. 

Pointer 

The Pointer tool allows each participant in a meeting to point to data anywhere within the 

meeting window. Each participant's pointer is displayed in a different color. 

The Pointer tool is only enabled during a shared meeting.  

The pointer direction (right, left, up, down) can be selected from the palette that appears when 

the Pointer tool is selected. You can also hide the pointer by clicking the "Hide Pointer" button 

from the palette that appears when the Pointer tool is selected. 

Selector 
The Selector tool allows you to draw a selection rectangle and copy the selection. The 

selected rectangle can then be pasted into another application. 

 

Using Annotation Tools during a Shared Meeting  

During an online meeting (see Shared Meetings), connected participants can create annotations to the 

meeting which are visible to all other participants in the meeting.  
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If the meeting is not synchronized by the meeting host, and the participant has not been set to View-Only, 

the participant may annotate on any page in the meeting. See What can the meeting coordinator do? and 

What can a meeting participant do?  

If the meeting is synchronized by the meeting host, the participant is restricted to annotating only on the 

displayed page.  

If the participant has been set to View-Only by the meeting host, the participant cannot annotate the 

meeting. The Zoom tool is always available, but zooming in/out of a page is not visible to other participants.  
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Play Controls  

The Play Controls toolbar allows you to replay the meeting like a movie. The meeting can then be played 

forward, line by line, at varying speeds. Playback can be restricted to either the current page, or set to play 

all pages.  

 

Some uses for the Play Controls:  

·  Viewing the meeting chain of events.  

·  Branching, which returns the meeting to a specific point and then duplicates the page. The 

duplicated page will create a new page with meeting data to the selected point, allowing you to 

explore a different idea without manually duplicating previous work, and keeping the original page 

intact.  

The Play Controls toolbar is displayed below along with a table of descriptions (from left to right) of each 

control on the toolbar:  
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Tool Description 

Jump to 

beginning 
Jumps to the very beginning of the meeting, which is always the original blank page. 

Drag control 

slider 

Allows you to step through the meeting forward or reverse by clicking on the drag line, or to 

immediately jump to a specific point in the meeting by dragging the drag bar to a location on 

the drag line. 

Play 

Replays the meeting from beginning to end, beginning with a blank screen. While playing, 

the Play button changes to a Stop button, allowing you to stop the playback. See Play 

Speed. 

Jump to end Jumps to the end of the meeting, restoring all whiteboard strokes and annotations. 

All Pages 

Sets the number of pages played by Play Controls. If "All Pages" is checked, clicking "Play" 

causes the entire meeting is played back. If "All Pages" is not checked, only the currently 

displayed page is played back. 

Loop 

Replays the meeting from beginning to end, beginning with a blank screen. Once the end of 

the meeting is reached, begins to replay from the beginning. Runs continuously. While 

playing, the Play button changes to a Stop button, allowing you to stop the playback. 

Play Speed 
Sets the speed at which the meeting is played. The slowest speed is 0.5x; the fastest speed 

is 8.0x. 
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Background Images  

You can import a file, screen capture, or data from the clipboard as a background image on the page 

currently displayed in Page View. The background image remains in the background of the currently 

displayed page. Any markings, including typed text, whiteboard marker strokes, or erasures, remain visible 

in front of the image.  

Note: During a shared meeting, background images are displayed to all participants.  

To load/remove a background Image:  

1. Navigate to the Meeting page you wish to load the background image into.  

2. Choose "Background Image" from the Page Menu, or drag-and-drop the file onto the page.  

This opens the Background Image dialog box which contains the following options:  

Button Description 

Load Image 

Opens the standard Open dialog box. To load an image, navigate to and select the file you 

want to load into the page background, and then click OK. 

The file to be imported is displayed in the preview window of the Background Image dialog 

box. To add, click OK. 

See Supported File Formats for Background Images, Loading an Excel Spreadsheet as a 

background image, and Loading a PowerPoint Presentation as a background image. 

Load From 

Clipboard 

Loads data from the computer's clipboard as the background image. If there is no data in 

the computer's clipboard, this button is disabled.  

The data from the system's clipboard is displayed in the preview window of the Background 

Image dialog box. Click OK to add. 

 

Note: In general, capturing a screen or copying data within an application will load data into 

the system's clipboard. 

Capture 

Screen 

Creates a capture rectangle by holding down the left mouse button and dragging the pointer 

across the screen until the rectangular outline encloses the area of the screen you wish to 
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capture. 

 

Note: Clicking Capture Screen causes Alfher Meeting Software to minimize.  

Release the mouse button, and the captured area is displayed in the preview window of the 

Background Image dialog box. Click OK to add the captured area as a background image. 

Remove 

Image 

Removes the background image from the page. Any whiteboard strokes or annotations will 

remain on the page. 

Keep Aspect 

Ratio 

Sets the proportions of the background image. If the "Keep Aspect Ratio" checkbox is 

checked, the image is loaded into the background in proportion to the original. If the "Aspect 

Ratio" checkbox is not checked, the image is stretched to fill the page when loaded into the 

background. 

Note: Load Image, Load From Clipboard, and Capture Screen load into the displayed page, rather than 

beginning a new page. When using these features, make sure that you are not overwriting a previously 

loaded background image.  

See Also:  

Supported File Formats for Background Images  

Loading an Excel Spreadsheet as a background image  

Loading a PowerPoint Presentation as a background image  
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File Import/Export/Autosave  
Export to File Format  

Import PDA Meetings  

Send  

Image Size  

Autosave  

Supported file formats for Save As/Send 

 

 

Export to File Format  

To save an Power2Board file as a different file format:  

1. Choose "Save As" from the File Menu.  

The "Save As" dialog box appears.  

2. Select the file format from the Save As Type pull-down list.  

If there are any special page options available for the selected format, they are displayed directly 

beneath the Save As Type pull-down immediately after the format has been selected.  

3. Click Save.  

For supported file formats, see Supported file formats for Save As/Send.  
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Supported file formats for Save As/Send  

The following is a list of file formats supported for saving a meeting or using the Send to distribute a 

meeting.  

·  Power2Board Software File (*.wbd)  

·  PDF (*.PDF)  

·  Vector PDF (*.PDF)  

·  HTML (*.HTM) (not available for Send)  

·  24-bit Bitmap (*.BMP)  

·  256 color Bitmap (*.BMP)  

·  Monochrome Bitmap (*.BMP)  

·  EPS monochrome (*.EPS)  

·  JPEG (*.JPG)  

·  TIFF (*.TIF)  

·  Metafile (*.emf)  

·  PowerPoint Presentation (*.ppt)  

·  PowerPoint Show (*.pps)  
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Shared Meetings  

 

What is a Power2Board meeting?  

An Power2Board meeting is a collection of notes and annotations which may consist of a single page or 

multiple pages. In either case, all pages contained in one Alfher Meeting Software'(*.wbd) file.  

A single meeting may have one or more participants who are sitting in one room using Power2Board to 

capture notes and diagrams. A single meeting may also have participants who are located in other locations, 

such as another floor in your building, another state, or even another country.  

What is a shared meeting?  

A shared meeting is a meeting that is broadcast over your local intranet or over the world-wide web 

(internet).  

At one location, the meeting coordinator/host uses the Power2Board system (software and hardware) to 

broadcast the meeting over the network (see Hosting/Sharing a meeting). Remote participants use Alfher 

Meeting Software or a web browser to log into the meeting (see Joining a meeting).  

The meeting is broadcast in real time, which means that remote participants see the lines as they are 

drawn.  

If the meeting coordinator allows participants this option, participants can annotate meeting pages, 

highlighting important points, and adding notes that can be seen by all other participants as well as the 

coordinator.  

Note: To allow remote participants (located outside of your local network firewall) to access your shared 

meeting, the meeting server must be located on the Internet. Power2Board currently hosts a meeting server 

that may be used by any Power2Board system user.  

Meeting Topics:  

Hosting/Sharing a meeting 

Hosting Multiple Meetings 

Sending an email invitation to a meeting 

Joining a meeting 

Accepting an email invitation 

Archiving Meetings 

Retrieving Archived Power2Board Meetings 
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What can the meeting coordinator do? 

What can a meeting participant do? 

Using Meeting Chat 

Web Tour 

Microsoft NetMeeting 

 

Hosting/Sharing a meeting  

The following explains how to host/share a meeting over your local intranet or the internet.  

If you share the meeting on your local intranet, only people within your intranet can access the meeting. If 

you share your meeting over the internet (using the Alfher server), participants from any internet location 

can access your meeting.  

Note: To share a meeting, you must be connected to the Power2Board hardware. Also, if there is any 

possibility that your network uses a proxy server, see Proxy Server Setup.  
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To host a shared meeting:  

1. Choose "Share Meeting" from the Meetings Menu or the "Share Meeting" button from the 

Application Toolbar.  

The Share Meeting dialog box opens.  

2. Under "Meeting Information", enter:  

o Meeting Name. The meeting name is the name shown in the Join Meeting dialog box. The 

meeting name is saved as the default name for subsequent meetings, until you change it. 

The meeting name can be up to 20 characters.  

o My Name. The name displayed in the Participants/Chat View. See Using Meeting Chat.  

o Notes. Any notes/comment you would like to include.  

o Publish Meeting Name. Select "Publish Meeting Name" if you want the name of the 

meeting to be visible to network users who are attempting to join a meeting using either the 

Join Meeting (see Joining a meeting) dialog box. 

o If you do not publish the name, guests will need to know the full meeting name beforehand 

and manually type it into the Join Meeting dialog box.  

o Password/Confirm/Use Password. If a password is required, check the "Use Password" 

checkbox and type the same password into both the Password and Confirm text boxes.  

The password must be at least 6 characters, and can be up to 20 characters.  

o Send Meeting Invitation. Meeting invitations are email invitations that are sent out using 

your standard mail client. If "Send Meeting Invitation" is checked, the Send Invitation dialog 

box opens once you click the Share button. See also Sending an email invitation to a 

meeting.  

o Archive Meeting on the Server. An archived meeting allows other Power2Board users to 

search for, view, download, edit, and/or delete your meeting (based on the archive 

privileges you select). If "Archive Meeting on the Server" is checked, the Archive Meeting 

screen opens after you click the Share button. See also Archiving Meetings.  

Notes:  

o While the Archive Meeting screen appears after clicking the Share button, your selected 

archive parameters are not saved to the server until you click the End Meeting button.  

o During your meeting, you may archive the meeting (or change your parameters) at any time 

by using the Meeting menu selection, and choosing Archive Meeting.  
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o If you did not check the archive meeting box, you will be prompted at the end of your 

meeting to archive your meeting to the server.  

3. Under "Server Information", select the server that will host the meeting.  

The pull-down menu lists the Alfher Server and any other servers you have previously added to 

your server list. See also: Adding a Meeting Server.  

Note: For Windows, if you wish to host the meeting from your computer, select "Use my PC to host this 

meeting", and then type in a port number. For most occasions, the default port value of 80 is best.  

4. Notify guests of the meeting name, meeting time, and password, if required. See also: Sending an 

email invitation to a meeting.  

5. Click "Share."  

Your shared meeting is now available on the network using the specified meeting server.  

Note: If a participant is attempting to join a meeting, but is unable to see the meeting name in the Join 

Meeting dialog box, both the meeting host and participant should check their proxy server settings. See 

Proxy Server Setup. Also, check to make sure that you checked "Publish Meeting Name" in the Share 

Meeting dialog box.  
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Sending an email invitation to a meeting  

You can invite others to a shared meeting by sending an email that contains a link or URL. In order to send 

email invitations, you must currently be sharing a meeting. Remote participants cannot send out invitations.  

To send an email invitation:  

1. Make sure you are sharing a meeting. See Hosting/Sharing a meeting.  

2. Choose "Send Invitation" from the Meetings Menu.  

This opens the Select Language dialog box.  

3. Select the language to be used for the email invitation, and then click Continue.  

Note: Your email program may or may not ask you to select the email profile to be used.  

An Power2Board Meeting Request appears in your email application send mail window.  

4. Enter the email addresses of the recipients in the To: field.  

The email invitation is sent with a link to download the latest Meeting Software and links to enable the user 

to join the meeting via their web browser or Meeting Software.  

See Also:  

Accepting an email invitation 

Joining a meeting 
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Joining a meeting  

There are two ways you can join meetings:  

·  Using the Meeting Software (see To join a meeting as a Meeting Software user:).  

·  Using a web browser (see To join a meeting as a web user:).  

To join a meeting as a Meeting Software user:  

1. Choose "Join Meeting" from the Meetings Menu.  

2. In the Join Meeting dialog box, select the meeting server, enter your name, and select a meeting 

name from the "Meeting" list.  

The "Meeting" list shows active meetings whose names have been published.  

If the pull-down menu does not include the meeting server you want, you can manually type the 

server name. You can also add a server to your server list, so that you can quickly select it on 

another occasion. See Adding a Meeting Server.  

3. Click "Refresh" to update the list of published meetings.  

4. If the meeting appears with a Lock icon, enter the password.  

If the meeting is not listed, enter the meeting name, and a password if required.  

5. Click "Join."  

There are restrictions on what a meeting participant can do within a shared meeting. For details on what you 

can do while connected to a meeting, see What can a meeting participant do?  

When the host ends the meeting, participants receive the message "The meeting has ended." The meeting 

remains visible on your desktop. Once disconnected, participants still can print, save, annotate, and modify 

the meeting.  

If, at any point, you want to leave a meeting, choose Leave Meeting from the Meetings Menu, or click the 

Leave Meeting icon from the Application Toolbar.  
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To join a meeting as a web user:  

 

1. Launch Internet Explorer.  

2. In the "URL" text box (Address or Location), type the IP address or DNS name of the computer 

hosting the Meeting session.  

If the meeting is hosted by the Alfher server, click the "Meetings" button.  

3. Type your name in the "My Name" text box, and the meeting name in the "Meeting Name" text box. 

In the "Meeting Password" text box, type the password, if required.  

4. Click "Join a Meeting."  

If the meeting is in session, the Meeting Software window appears in your web browser. 

Participants will see the full contents of the meeting.  

Remote participants cannot print or save the meeting to disk. However, the host can save the 
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meeting and make it available to web users for viewing in a web browser or another application.  

At any point, you can choose "Leave Meeting" from the Meeting menu.  

See also:  

Hosting/Sharing a meeting 

Sending an email invitation to a meeting 

Accepting an email invitation 

What can the meeting coordinator do? 

What can a meeting participant do? 

Using Meeting Chat 
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Accepting an email invitation  

You can accept an email invitation in one of the following ways:  

·  Click the http: link to join through your web browser.  

·  Click the file: link to join through your copy of Meeting Software. The latest version of Meeting 

Software can be downloaded from the download page.  

·  Manually open your browser, and copy and paste the link into the browser.  

 

See Also:  

Sending an email invitation to a meeting 

Joining a meeting 

Checking For Software Updates 
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Archiving Meetings  

There are two areas in Power2Board Software where you can select to archive an Power2Board meeting.  

·  While hosting a shared meeting. In the Share Meeting dialog, click the "Archive meeting on the 

server" checkbox to have the Archive Meeting Screen open after the Share button has been clicked. 

See Hosting/Sharing a meeting for more information about sharing a meeting.  

·  After creating/completing a meeting, you have the choice of archiving that meeting (to the server) 

for viewing and/or downloading by other Power2Board users or only for those users with 

password-access.  

To select this option:  

o Save the meeting  

o Choose Archive Meeting from the Meetings menu  

o Select the server to archive the meeting on and click Continue. The Archive Meeting 

Screen will open next.  

Next step: Archive Meeting Screen  

 

Archive Meeting Screen  

Use the Archive Meeting screen to define meeting information, security access requirements, the file 

access expiration period, and review the Conditions of Use.  

Meeting Information Section  

·  Meeting Name: Retain the current saved meeting name or create a new name for the archived 

meeting.  

·  Publish Meeting Name checkbox: Check to have archived meeting published (available for 

searching)  

Access Security Section  

·  Password access - check the box to require a specified password before an Power2Board user 

can retrieve your archived meeting. If checked, enter a password, and then re-enter it for 

confirmation.  
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·  Security Code - check the box to require a specified security code before an Power2Board user 

can edit or delete the archived meeting file. Note: if the box is checked, but no security code is 

specified, the defined password is automatically used.  

Access Period Section  

·  The text appearing in this section displays the current expiration period for storing and accessing 

the archived meeting file. After this time, the file is deleted from the server.  

·  Click the Change button to edit the current criteria via the Access Period screen, as described 

below.  

Access Period Screen  

·  Meeting Storage - choose the default, or select a specific date.  

·  Meeting File Availability - define the duration the archived meeting will be available for other 

Power2Board users to view and/or download.  

o Always (until deleted) - available until same defined final date as meeting storage date.  

o During Specific Time Period - specify exact days and times for starting and ending 

availability. Note: End Date may also be until the file is deleted from the server (see final 

meeting storage date) by checking the Until Deleted box.  

·  Summary section - text appearing in this section displays the updated expiration period for storing 

and accessing the archived meeting file. After this time, the file is deleted from the server.  

Archive Meeting Buttons  

·  Conditions of Use button - click this button to review the conditions of use for the Power2Board 

product.  

·  Help button - click to display the context-sensitive help for this screen.  

·  Archive button - when all your selections are complete, click the Archive button.  

·  Cancel button - click to cancel your archive request.  

See Also:  

Hosting/Sharing a meeting 

Joining a meeting 

Retrieving Archived Meetings 
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Retrieving Archived Meetings  

From the Meeting menu selection, you may search and retrieve archived meetings for viewing or 

downloading at any time.  

Notes:  

·  To retrieve meetings, under the Meeting menu, choose Retrieve Meeting.  

·  Some meetings may require password-access.  

The following topics describe the elements and activities available to you via the Retrieve Archived Meeting 

screen.  

Recent Archived Meetings Screen 

Change Archived Meeting Screen 

By Meeting Name Screen 

Full Search Screen 
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What can the meeting coordinator do?  

The meeting coordinator/host is the person responsible for setting up and broadcasting the shared meeting.  

In the course of the shared meeting, the meeting coordinator can do anything Alfher Meeting Software can 

do: draw whiteboard strokes, create annotations, create new pages, delete pages, etc.  

Note: When the coordinator/host closes a shared meeting, all participants are disconnected. As the 

meeting coordinator, make sure the meeting is completely over before attempting to close the meeting.  

The following special features allow the meeting coordinator to control the shared meeting:  

Feature Description 

Synchronize 

Forces all participants to view the same page as the meeting host. If synchronize is 

disabled, remote participants can view any page they wish during the meeting. If 

synchronize is enabled, remote participants are unable to change pages. However, if 

synchronize is enabled, remote participants can annotate pages. 

The synchronize feature is located in the Meetings Menu. A checkmark indicates that 

synchronize is enabled. 

A synchronize button is also available on the page view toolbar (see Views and the 

view-change buttons). When synchronize is enabled, the button is depressed. 

Set View 

Only 

Allows the coordinator to mute one or more of the remote participants.  

When a particular remote participant is muted, the participant cannot add annotations to the 

meeting page (Annotation Tools). However, the participant can still type comments into the 

Participants/Chat View (Views and the view-change buttons). 

 

Note: The meeting coordinator cannot be muted. 

Set View Only can be accessed from the Meetings Menu or the Application Toolbar. You 

must be in the Participants/Chat view, and have selected one or more participant name(s). 

The Meetings Menu and Application Toolbar also contain a Set View Only-All option, which 

allows you to mute all participants at once. 
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Exclude 

Allows the coordinator to disconnect a meeting participant from the shared meeting. 

Exclude can be accessed from the Meetings Menu or the Application Toolbar. To use this 

feature, you must be in the Participants/Chat view and have selected one or more 

participant name(s). 

See Also:  

Web Tour 

What can a meeting participant do? 

 

 

What can a meeting participant do?  

As a remote participant, you have connected to an active meeting (see Joining a meeting) and the full 

shared meeting from the host computer is displayed on your computer.  

A remote participant does not have the same set of features as the meeting coordinator. Features that are 

different for a participant are described below.  

Feature Description 

Synchronize 

If the meeting coordinator has not enabled synchronize, remote particpants can view and 

scroll the pages in the meeting independent of other users. 

If the meeting coordinator has enabled synchronize, remote particpants are only able to 

view the page that the coordinator is viewing. However, remote particpants are still able to 

annotate the page. 

Set View 

Only 

If the meeting coordinator has set a remote particpants to View Only, the participant cannot 

annotate the page. 

Page 

functions 

For remote particpants, New Page, Duplicate Page, Clear Page, and Delete Page are 

disabled. 

Annotation Remote particpants cannot erase or undo annotations made by other participants. 

See Also:  

What can the meeting coordinator do? 

Views and the view-change buttons 

Using Annotation Tools during a Shared Meeting 
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Using Meeting Chat  

The Participants View is used to display all participants who are logged into a shared Power2Board Meeting, 

as well as to allow the participants to chat online during the meeting. To access the Participants View either 

click the "Switch To Participants View" button (see Views and the view-change buttons), or choose 

"Participants" from the View Menu.  

The Participants View contains two sections: the Chat Window and the Participants List.  

Chat Window  

The Chat Window allows participants in a shared meeting to send text messages to one another in the 

course of the meeting. Messages can be sent to anyone listed in the Participants List, by typing a text 

message into the New Message text box, and then clicking one of the buttons listed next to "Send To."  

�³

The following controls are contained in the Chat Window:  

Control Description 
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New 

Message 

Creates a new email message. Type the new outgoing text message into the "New 

Message" text box, and then select "All" or "Selected Participants" to send the message. 

See All and Selected Participants. 

Show 

Addressee 

Lists the name(s) of email recipients. If "Show Addressee" has been checked, once a text 

message has been sent, the participant(s) that the message was sent to are listed next to 

the message. 

 

Note: For incoming messages, the sender's name is always listed next to the message. 

Show Time 
Lists the time of email messages. If "Show Time" has been checked, once a text message 

has been sent, the time the message was sent to is listed next to the message. 

Color Coded 

If "Color Coded" has been checked, then incoming/outgoing text messages are color 

coded in the Chat Window. The color codes are defined as: 

·  Black - Incoming text message.  

·  Blue - Outgoing text message.  

·  Red - Priority text message. Incoming and outgoing.  

Priority 

Message 

Color codes a high-priority message. If "Priority Message" has been checked, the 

outgoing/incoming message is displayed in red.  

 

Note: If "Color Coded" is not checked, the message is displayed in black. 

All 
Sends the text message in the "New Message" text box to all connected participants. This 

button is disabled until a text message has been typed into the "New Message" text box. 

Selected 

Participants 

Sends the text message in the "New Message" text box to all selected participants in the 

Participants List. Multiple participants can be selected/deselected by holding down the 

Shift or Control button. This button is disabled until a text message has been typed into the 

"New Message" text box. 

Clear 
Clears all previously sent/received test messages from the Chat Window. However, does 

not clear any text in the "New Message" text box. 

To show/hide the Chat Window, click the green arrow located next to the Chat title.  
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See Also:  

What can the meeting coordinator do? 

What can a meeting participant do? 

Shared Meetings 

 

 

Participants List  

The Participants List displays a list of all participants in a shared meeting. For each participant, the following 

information is displayed:  

Item Description 

Participant 

Name 

The name of the participant as entered in the "My Name" text box in the Join Meeting dialog 

box. See Joining a meeting. 

Write 

Permission 

Write permission is displayed by an icon. When the participant has permission to annotate 

the meeting, a pen icon is displayed. When the participant does not have permission to 

annotate the meeting, the pen icon is displayed with a line through it. See Also: What can 

the meeting coordinator do?, What can a meeting participant do?. 

Connected 

At 
Displays the time the participant connected to the meeting. 

IP Address Displays the participant's IP Address. 

Notes 
Displays any notes entered into the Notes field in either the Share Meeting or Join Meeting 

dialog box. See also: Hosting/Sharing a meeting, Joining a meeting. 

See Also:  

What can the meeting coordinator do? 

What can a meeting participant do? 

Shared Meetings 
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Web Tour  

Alfher Meeting Software's Web View allows you to access web pages on the internet from the Alfher 

Meeting Software.  

Web View is itself a web browser which provides the most commonly used web browser controls, as well as 

allowing access to your "Favorites" links (see Favorites), or allowing you to set your home page (see Web 

Tour Setup).  

�³

Note: Web View does not allow pop-up windows. If you visit a website that contains pop-up windows a 

warning dialog box will appear informing you that pop-up windows are not supported.  

The Web Tour feature is controlled from within Web View and allows you to lead participants in a shared 

meeting from one web page to another. Each time you go to a new URL, your guests automatically go with 

you.  

Note: Web Tour is not supported in the browser version of Power2Board Software (accessed by joining a 

meeting through www.e-beam. com > Meetings).  
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To use Web Tour:  

1. Click the Web View button from the Views and the view-change buttons.  

2. Click the Synchronize Participants button.  

Note: Synchronization is required for Web Tour.  

3. Type in a web URL, or select an address from Favorites.  

4. To set a home page, see Web Tour Setup.  

 

Web View Toolbar  

The Web View toolbar contains the following controls:  

Control Description 

Back 

Displays the previous viewed web page.  

 

Note: Back is disabled while you have viewed only one web page. 

Forward 

Return to the web page you were viewing before you clicked Back. 

 

Note: Forward is enabled only when you have used the back button. 

Stop Stops loading a web page. 

Refresh Reloads the current web page. 

Home 

Opens the Home page.  

 

Note: When you are using Power2Board Software, Power2Board's web page is the home 

page. To set your home page, see Web Tour Setup. 

Favorites 
Displays your list of favorite websites. The addresses are gathered from your Windows 

Favorites directory. 



� � � � �� � � � �	 

� � � � � � ��	 � 
 ��� � �� � �

 65 

Web Page 

URL 

Displays the URL of the current web page as a pull-down list. To go to a new web page, 

type in a new URL or select a URL from the pull-down list, and then click Go. 

Snapshot 

Takes a snapshot of the web page currently shown in the Web View and loads it into the 

background of a new page in your meeting. This feature is especially useful for building 

presentations, because once the web page has been pulled in to a background image, you 

can annotate it using the Annotation Tools. 

Go Opens the web page listed in the Web Page URL pull-down list. 

Update 

Participants 

Synchronizes the other participants to the current web page.  

 

Note: This feature is available to the host once the Synchronize Participants button has 

been clicked. 

See Also:  

Web Tour Setup 

Views and the view-change buttons 

Hosting/Sharing a meeting 

What can the meeting coordinator do? 

 

 

Web Tour Setup  

You can set the Web Tour home page and clear your history list from Web Tour Setup.  

Web Tour Setup is accessed by choosing Setup from the Edit menu, and selecting the Web Tour Setup tab.  
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Microsoft NetMeeting  

If you are a Microsoft Windows NetMeeting user, you can use the Power2Board system as input for a 

NetMeeting.  

 

To use Netmeeting with Power2Board:  

1. Install NetMeeting software (available separately) on you computer.  

2. Set up the Power2Board system as described in your setup guide.  

3. Launch Alfher Meeting Software and make sure the Meeting Software is connected to the 

Power2Board hardware.  

Note: If you were in Projection mode just prior to launching Alfher Meeting Software, switch to Whiteboard 

mode (see How to Select a Mode).  

4. Choose "Microsoft NetMeeting" from the Tools Menu.  
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NetMeeting starts, and the NetMeeting whiteboard is displayed on your computer.  

5. Using any of the Power2Board system's electronic pens, write on your whiteboard. Your strokes are 

recorded in the NetMeeting Whiteboard.  

6. Alternatively, you can use NetMeeting with your projection system in Projection mode.  

Note: For detailed help with Microsoft NetMeeting, access the Microsoft NetMeeting help system or 

Microsoft's website. 
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Meeting Software's Windows system tray menu  

The Alfher Meeting Software menu appears as an icon in the Windows system tray even when you are not 

using Power2Board Software. The following menu items are offered from the system tray:  

Menu Item Description 

Capture from 

Whiteboard 

Puts Power2Board Software in Whiteboard mode and launches Alfher Meeting Software 

used to collect whiteboard data. See What is Whiteboard mode? 

Capture from 

Flipchart 

Puts Power2Board Software in Flipchart mode and launches the meeting application 

used to collect flip chart data. See What is Flipchart mode? 

Use with 

Projector 

Puts Power2Board Software in Projection mode. Your electronic pen now acts as a 

virtual mouse. See What is Projection mode? 

Disable 

System 

Disconnects Power2Board Software from the hardware, freeing the communication port 

on your computer. You can still use Alfher Meeting Software. When the hardware is 

disconnected (or cannot be detected), you will see a red line through the Power2Board 

icon in the system tray. See Icons that represent a mode. 

Projection 

Toolbar 

Provides access to all Projection mode functions. When Power2Board Software is in 

Projection mode, the Projection Toolbar provides access to all Projection mode 

functions. See Projection Toolbar. 

A checkmark next to "Show Projection Toolbar" indicates that the toolbar is displayed. 

Also can be used to access the Annotating your desktop features. 

Annotate 

Screen 
Opens the Screen Annotation Toolbar. See Annotating your desktop. 

Show 

On-Screen 

Keyboard 

Displays On-Screen Keyboard menu. If an on-screen keyboard is supported and 

installed on your operating system, the On-Screen Keyboard menu option causes the 

On-Screen Keyboard to be displayed and allows it to be used in Projection mode. 

Projection 

Mode 

Settings... 

Opens the Projection Setup dialog box. This dialog box allows you to turn on/off various 

warning messages. 
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Calibrate 

Projection 

Area... 

Initiates the Projection mode calibration wizard. See Calibration. 

System Setup See Setup. 

Detect System Attempts to detect the hardware. See How to Connect. 

Calibrate 

Capture Area 
Opens the hardware calibration wizard. See Calibration. 

Help Opens the Power2Board Software help system. 

Exit 
Completely closes down Power2Board Software and removes the Power2Board icon 

from the system tray. 

See Also:  

How to Select a Mode 

Calibration 

Alfher Meeting Software 

Power2Board Software's Projection mode 

 

 

 

 

 

 

 


